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Before You Begin
These manual describes how to operate and configure the PC AFT F PC attendant console on your 
T-Octopus F 200/400/600/650 / IP Netpackage communications platform.

This manual is supplied with the PC AFT F as online help and can be called up at any time page 15.

While the instructions describe all PC AFT F functions, you may find that some functions you wish to use are not 
available. This is due to one of the following reasons:
• The function has not been configured for your PC AFT F system. Address any questions to your system ad-

ministrator.
• Your communications platform does not support this function. Address any questions to the sales represen-

tative responsible for upgrading your system.
• You do not have the latest version of the PC AFT F software. Contact your sales representative to update the 

software.

The information provided in this document contains merely general descriptions or characteristics of perfor-
mance which in case of actual use do not always apply as described or which may change as a result of further 
development of the products. 
An obligation to provide the respective characteristics shall only exist if expressly agreed in the terms of contract.

PC AFT F
In purchasing the PC AFT F, you have acquired an advanced PC attendant console for your communications 
platform.
Your PC must be connected to your communications platform to perform all switching functions from your PC.
Three different options are available for this, depending on the implementation site:
• Via the octoClient software installed on your PC.
• Via a USB cable to an T-Octophon F system telephone at your communications platform.
• Via the Control/Datenadapter on the Octophon system telephone at your communications platform.

The PC AFT F software is compatible with different Windows operating systems so that you can conveniently 
transfer telephone calls and look up phone numbers in Outlook "Contacts" while simultaneously running other 
PC applications such as Microsoft® Office programs.

The PC AFT F attendant console provides you with:
• A variety of switching and administration functions;
• A high degree of user friendliness thanks to the:

– Clearly designed Windows-based user interface;
– Straightforward operation using a keyboard and mouse;

• Simultaneous use of other PC applications;
• Supports two screen solutions (ask your relevant service personnel),
• Direct switching from Microsoft Outlook "Contacts", and
• A user-friendly search option in Microsoft Outlook "Contacts", busy lamp field and system telephone direc-

tory.
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Basic Operating Instructions

User Interface of PC AFT F

PC AFT F main window

Busy lamp field(s) (display optional)

Menu Window (may be activated)
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How To Use These Operating Instructions

You will find a graphic representation of the steps in logical sequence on the left side. Below 
is an explanation of the symbols:

Click the right mouse button once.

Hold down the left mouse button and move the mouse (click and drag).

Click the left mouse button twice.

Click the left mouse button once.

Enter letters or numbers from the PC keyboard (user names and station numbers).

Select an option from the menu bar, a pop-up menu or a tab in a program window.

Press Return to accept input from the keyboard or confirm a program call.

Click the button with the left mouse button.

Press the key on the PC keyboard.

1. A numbered list describes steps you must complete in the order given.

• Bulleted text indicates an enumeration.

page 9 Reference to a page.

Space Bar

F3

Note or remark.
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Overview of Features
• Incoming and outgoing call display
• Call answering/dialing/transferring
• Toggling between two calls
• Three-party conference
• Call holding and parking
• Redialing of the last ten numbers dialed
• Dialing with busy lamp field and repertory dial keys
• Dial via Caller list
• Callback and send message
• Call override
• Activate/deactivate call forwarding
• Activate/deactivate night answer
• Telephone book functions (in the ETB using Microsoft Outlook "Contacts"):

– Look up and display stations
– Look up and display station data
– Automatic provision of the station number for dialing from Microsoft Outlook.

Main Improvements and Changes

• Enhanced caller list page 70
• Statistics function for incoming calls with extensive sorting options page 97
• Dial in canonical form with Outlook “Contacts” page 78 and LDAP searches 

page 83
• Internal telephone book (ETD) page 72 can be imported from PC AFT F V4.0 (ask re-

levant service personnel for further details)
• Simplified Configuration Manager start-up page 92
• Zoom option in the busy lamp fields page 21
• Message and Substitute function in the busy lamp field page 25, page 25
• Sort function in the busy lamp field page 27
• Improved program interface (for example, toolbar regrouping, integrating the display in 

the main window)

Convenient Call Number Search

The PC AFT F enables you to access different data sources for the station number search, 
depending on your configuration.
• Searching in the Electronic Telephone book (ETB) page 72
• Searching in the Microsoft Outlook contacts (if Microsoft Outlook is installed) 

page 78
• Searching in the telephone book page 81
• Searching in the telephone book on CD-ROM (if the CD-ROM is available) page 82
• Searching per LDAP server (if LDAP server is available) page 83

If a desired function is not available, please contact the relevant service personnel.
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Target group for this Manual

This manual is intended both for personnel working with the PC AFT F attendant console 
who are familiar with the Windows user interface and for System Support (service person-
nel), who configure and oversee the PC AFT F attendant console.

The manual contains all the information you will need to operate and configure the PC AFT F 
attendant console:
• To make important information easy to find, the first section of this manual deals with 

Operating the PC AFT F page 13.
• The second section describes Configuring the PC AFT F and operating the Configura-

tion Manager page 85.
• If you run into any problems operating the PC AFT F, refer to the third section of this ma-

nual, Error Correction in PC AFT F page 101.
• The chapter Important Keyboard Commands provides an overview of shortcuts and 

function keys page 107.

Requirements

You or System Support must install the attendant console hardware and PC AFT F software 
for the Microsoft Windows operating system on your PC (see Installation Instructions in the 
PC AFT F CD-ROM booklet).

The PC’s power management system must not be activated during 
PC AFT F operation.

To use the telephone book functions (ETB) with Microsoft Outlook, Microsoft Outlook must 
be installed on the PC.

An LDAP server must be available to use the LDAP search function.

Operating PC AFT F requires some elementary knowledge of PCs and Windows.

For hardware and software requirements, please refer to the Installation Instructions in the 
PC AFT F CD-ROM booklet.

Operating the PC AFT F

Whenever the PC AFT F is used with various user profiles, it may be necessary to 
change the access rights for the configuration files before configuring the PC AFT F 
itself. If this is the case, please contact your system specialist or administrator.
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Operating PC AFT F
You can configure your attendant console PC so that the PC AFT F switching program starts 
up automatically when you switch on the PC. 
If the program has not been configured to start up automatically, you must start it manually 
or set up PC AFT F for automatic start up.

Automatic startup

Switch on the attendant console PC. As soon as your operating system loads, PC AFT F au-
tomatically starts up and the program window opens.

Manual startup

When you install the program, it is added to the Programs section of the Start menu of your 
operating system.

Start up the PC AFT F from the Start menu. The program window with the attendant monitor 
opens.

Configuring Automatic Startup (Example: Windows 2000)

1. Click on the “Start” button on the task bar and select “Settings”, “Taskbar & Start 
menu...", and then click the “Advanced” tab in the next window.

2. Click the “Advanced” button.
The “Explorer - Start menu” window will open.

3. In the left column, open the “Program files” directory and locate the PC AFT F directory.

4. Right-click to copy the “PC AFT F“shortcut to the right column.

5. Go to the "Autostart" folder in the left column and insert the “PC AFT F” shortcut into the 
right column, using the right mouse button.

6. Close “Exploring”. On the “Task Bar Properties” screen, click “Apply”, then “OK”. 
Exit and re-start the PC.
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User Interface - Desktop

The PC AFT F program windows are your work area.
The program windows can be independently positioned on the screen.

Program windows include:
• the PC AFT F main window

with menu bar page 15, toolbar page 16, the attendant monitor page 18 and 
status bar page 17.

• the busy lamp fields page 21 (max. 3, display optional) and
• the menu Window page 28 (may be activated).

For certain functions, you can open additional windows, for example:
ETD page 72, Search the telephone book page 81, Directory CD search window 

page 82, LDAP server search window page 83, Windows Notebook page 67.

Busy lamp field(s)
(Display optional)

Menu Window
(may be activated)

Status Bar

Menu bar Toolbar

Switching monitor
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Main Window

Menu bar

The menu bar contains a series of main menu options. Clicking one of these main menu op-
tions with the left mouse button opens a corresponding submenu (pull-down menu) with ad-
ditional menu options.
• File

This menu allows you to configure general settings for the PC AFT F. The Exit command 
terminates the PC AFT F application.

• Edit
Use this option to activate DTMF suffix-dialing during a call, select the night answer des-
tination and activate/deactivate various functions.

• Window
With this menu, you can call the busy lamp field, the Windows notebook and the search 
window.

• Repdial keys (optional)
You can dial your party directly from this menu with these repdial keys.
(This menu option only if you have configured repdial keys in the PC AFT F).

• Find
From this menu, you can selectively search for the names, companies, cities or postal 
codes of any stations in the Microsoft Outlook "Contacts" folder.

• Paging (optional)
This menu option allows you to broadcast a speaker announcement to telephones in a 
specific group. 
(This menu option appears only if you have configured paging groups and have activat-
ed them in the PC AFT F.)

• Language
Use this option to set the language that you want PC AFT F to use for menus and dialog 
boxes (windows)

• ? (Help)
Use the "Help" option to access PC AFT F the context-sensitive online help function, 
where you will find general information on the program layout and explanations of the 
individual functions.
Use the "About..." option to view general information about PC AFT F.
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Toolbar

In the talk state or idle state you can call important functions from the toolbar by clicking 
them with the mouse.
In the case of functions which can be activated or deactivated, an icon in the status bar 

page 17 displays the activated function.
Some functions appear in the toolbar only if they are configured for your telephone.

Call busy lamp field page 21.

Display caller list page 70.

Open Configuration Manager page 92.

Display list of most recently dialed numbers page 40.

Activate/deactivate callback page 54.

Override busy station page 52.

Initiate conference page 50.

Set volume page 34.

Release trunk page 61.

Transfer trunk page 60.

Activate/deactivate night answer page 66.

Activate/deactivate call forwarding page 63.

Send message page 57.

Activate/deactivate calling line identification restriction page 53.

Initiate DTMF suffix dialing (tone dialing) page 38.

Open door lock page 35.

Request call charges (pay phone) page 68.

Speaker call page 56.

Open menu window page 28.

Call up Electronic Telephone Book (ETD) page 72.

Display popup menu for advanced search in Outlook page 80.

Start telephone directory CD page 82.

Opening search window for LDAP server page 83.

Open search window for telephone book page 81.
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Status Bar

Advisory and system messages on the status bar:

• The current status of PC AFT F during the loading operation is displayed on the right-
hand side. The program is ready when System ready is displayed in the status bar.
If the data of the communications platform has been modified, the Please wait message 
appears in the system bar to inform you that the program is being updated with the new 
system data.

• In operational status, icons for the current settings are displayed on the left-hand side 
e. g. "Camp-on without tone" . 
To deactivate a function, left-click the relevant icon.
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Attendant Monitor

The attendant monitor is the main work area of the attendant console. From here, you can 
control the switching functions and obtain information from your communications platform.
• You can answer all pending calls from the call list. 
• Any held or parked calls are indicated in the call list.
• The switching area allows you to initiate the switching functions.
• The traffic display indicates the current trunk seizure.

A pending call appears in the call display. When you call a party or answer a pending call, 
the data appears in the left column of the traffic display. If you call another station for switch-
ing purposes, the data for this station appears in the right column of the traffic display; the 
data of the held station appears in the call display.

Call Display

Waiting calls are displayed in the list boxes on the call display. Using the mouse, you can 
scroll through the list boxes and select individual calls. A call can be answered by clicking 
the answer call button .

Call list

Call display Switching area

Traffic display

E: 0891234567

I: 38041 Peters

P: 38559 Miller

List boxes:

Answer call

Open list box

External calls
Internal calls

Personal calls
Number of waiting calls
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You can also recognize the different call types by means of the flags and the list field where 
the call is displayed:

A priority call is always displayed at the top of the middle list field so that it is clearly visible.

The number of waiting calls is indicated to the right of the list boxes both numerically.

Switching area

You can call a user manually by entering the station number in the "Name / Station number" 
entry field of the switching area. If you enter a name, a search for this name will be initiated 
in page 93 either the ETD page 41 or Microsoft Outlook “Contacts” page 78, de-
pending on the Configuration Manager settings.

Call Processing Buttons

 page 48

 page 36

 page 51

 page 49

 page 36

Dialing Buttons

 page 37

 page 37

Only visible in the case of automatic line seizure:

 page 38

Type1

[1] Type number for flagging in the statistics page 97.

Flag Field Call type

0 E: External External call

1 I: Internal Internal call 

2 P: Private Private call 

3 I: Internal Doorbell call

4 R: Internal Callback

5 W: External External recall

6 W: Internal Internal recall

7 A: External External call intercept 

8 A: Internal Internal call intercept 

9 W: Internal Internal recall from park

10 W: External External recall from park

11 P: Internal Priority call
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Traffic Display

The upper column of the traffic display shows the first party when you answer or place a call 
(same display as in an T_Octophon device).
The passive call is displayed in the lower column of the traffic display if, for example, you put 
a party in consultation state to call a second party.

For internal calls, the station number and (if possible) the station name are displayed. For ex-
ternal calls, the station number and possibly the name are displayed only in the case of a net-
working connection (ISDN, IP) with CorNet N.

Call list

The call list indicates all calls which are currently on hold or parked.
If a text has been entered by the station user in connection with holding or parking, this is 
also displayed.
For information about configuring text input in connection with holding or parking, see 

page 95.

You can retrieve the call from the hold page 48 or park page 51 status by double-click-
ing the left mouse button on the entry in the call list.

Name and/or number of passive party

Name or number of active party









Description of the situation
Holding/parking position

Held/parked station

Trunk> Position 0 - Smith is waiting for Miller
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Busy Lamp Field

The Busy Lamp Field (BLF) is used for signaling the line status of individual stations (e. g. "ex-
ternal busy") with colors and for convenient and rapid station number dialing.

Representation

Up to three busy lamp fields may be configured, each with max. 240 status keys, i.e. 720 sta-
tus keys in total.

Every status key, which was assigned to a station page 24, displays the station’s number 
in Number mode. When the mouse pointer pauses on the key, the associated name, if avail-
able, is displayed as a tool tip. 

In Name mode, station numbers (if available) are immediately displayed as key labels. The 
relevant station number is displayed as a tool tip. Up to 140 status keys may be configured 
per BLF in this mode.

Depending on the status key color configuration, different colors are used to signal the trunk 
status of the station.

You can resize a busy lamp field by clicking and dragging its margin. The size of the status 
keys and their labeling is automatically adapted; the number of status keys remains un-
changed.

For further details on configuring BLFs (number of BLFs, labels, number of status keys, color 
and mode) see page 93 and page 94.

To select a station, click the status key assigned to this station page 39.
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Calling Up the Busy Lamp Field

The busy lamp fields opens automatically when you start PC AFT F (depending on configu-
ration page 94). If it doesn’t appear for some reason, follow the steps below to open it:

Click the busy lamp field button in the toolbar.

or

Select the BLF option from the Window menu.

The busy lamp field (max. 3 configurable) appears:

When you click one of the labeled status buttons, the number for this station is automatically 
dialed page 39.

Double-clicking a status button has the same effect as single-clicking it.

Status key
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Right-clicking displays a context-sensitive pop-up menu with additional functions (example):

You can perform the following functions via the pop-up menu on the BLF:
• Speed transfer page 40
• Deleting a Station page 27
• Manual Input page 24
• Inserting an empty field page 26
• Inserting Captions for Station Groups page 26
• Creating a Note for a Station User page 25
• Determining a Substitute for a Station page 25
• Sorting Stations page 27
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Entering a Station

To assign status buttons to internal stations, you must label the buttons with the station num-
bers.
This is possible by:
• setting the phone numbers and names of internal stations on the system on which the 

PC AFT F is registered page 86,
• manual input.

Manual Input

Call the busy lamp field.

Right-click the desired status key.
A popup menu with several functions opens.

Select “New entry” from the popup menu.
The following dialog box opens.

Enter the station number and click OK to confirm your entry.

The following dialog box opens.

Specify, if desired, the name of the station. Confirm with the "OK" button.

The station is now saved under this status button.

You can also store codes for controlling voice mail systems and answering machines 
on status keys.
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Creating a Note for a Station User 

You can store a note or information for any station entered in the BLF (e.g. Mr Müller is on 
holiday).

Select the busy lamp field.

Right-click the desired station.
A popup menu with several functions opens.

Select "Note" from the popup menu.

Select "Add/change note" from the popup menu.
The dialog for entering a note opens.

Enter the relevant text.

Determining a Substitute for a Station 

You can assign two substitutes to each station entered in the BLF. If necessary, you can call 
the substitutes directly Page 39.

Select the busy lamp field.

Right-click the desired station.
A popup menu with several functions opens.

Select "Substitute" from the popup menu.

In the Substitute menu, select the "Change Substitute 1/2" menu item.
The dialog for entering a substitute opens.

Enter the substitute’s station number (for example, 0089123456) and confirm your entry 
with "OK".

To delete a note, invoke the "Note" menu item and click the specified note. Click "OK" 
to confirm.

To delete a substitute’s station number, invoke the Substitute dialog as described 
above and click "Cancel". Alternatively, delete the station number entry from the dia-
log and confirm with "OK". Click "OK" to confirm.
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Inserting Captions for Station Groups 

You can insert captions for a status key in the BLF in order to define a station group.

Select the busy lamp field.

Right-click the desired status key.
A popup menu with several functions opens.

Select "Insert a caption" from the popup menu.
The dialog for entering a caption opens.

Specify the relevant text for the station group caption (e.g. company name or department).

The key caption is underlined for display.

Inserting an empty field 

In the BLF in the area containing predefined status keys, you can insert a key without any 
function (empty field) to which you can assign a station or caption at a later stage.

Select the busy lamp field.

Right-click the status key before which you want to insert the empty field.
A popup menu with several functions opens.

Select "Insert an empty field" from the popup menu.
An empty field is inserted above the selected status key.

All subsequent status keys move down a position as a result of this insertion. The 
functionality of the last key (lower right corner of the BLF) is deleted by the BLF.
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Moving station numbers

In the BLF, you can move station numbers from one status button to another in order to, for 
example, group certain station numbers.

Select the busy lamp field.

Press the "Ctrl" and "Shift" keys while simultaneously left- or right-clicking the status button 
that you want to move.

While holding down the mouse button, drag the status button to the position required. When 
you release the mouse button, the station is moved to the new position.

Deleting a Station

Select the busy lamp field.

Right-click the desired status key.
A popup menu with several functions opens.

Select “Delete entry” from the popup menu.
The station is deleted from the busy lamp field.

Sorting Stations 

You can sort the stations of a group in alphabetical order in the BLF.

Select the busy lamp field.

Hold down the "Shift" key and, at the same time, right-click the first status key of the group or 
area you want to sort. The name of the status key is displayed in bold font.

Hold down the "Shift" key and, at the same time, right-click the second status key of the group 
or area you want to sort. The name of the status key is displayed in bold font.

Right-click one of the status keys displayed in bold font.
A popup menu with several functions opens.

Select "Sort" from the popup menu.
A list of all subscribers for the selected area is displayed in alphabetical order.

Ctrl +

Deleting a station from the busy lamp field does not delete it from your system; in oth-
er words, you can reconfigure it at any time page 24.

+

+
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Menu Window

The Menu Window emulates the telephone display and keys (2 lines for Octophon 22/26 
and T-Octophon F 20/30/40 / 8 lines with Octophon 28 and T-Octophon F 50). Likewise, 
some of this information is constantly displayed in the upper area of the traffic display of the 
attendant monitor page 18.

Calling the Menu Window

The menu window dialog box automatically appears when you initiate a procedure such as 
sending messages.

You can also call the menu window manually to execute functions or procedures that cannot 
be initiated via toolbar buttons or pop-up menus (for a description of these functions and pro-
cedures and how to execute them, refer to the user manual for your communications plat-
form).

Click the "Menu Window" toolbar button.
The menu window is displayed.

Operation

The keys have the following meanings:

Confirm a function.

Scroll between functions.

Confirm changes
(corresponds to the "DIAL" key on the Octophon 28/T-Octophon F 50).

Scroll between lines.

Delete input one letter at a time from right to left.

Call up window to input alphanumeric characters.

Set telephone (e. g. ringer volume).

Close the menu window.

To avoid incorrect menu text display (some characters missing), data compression 
should not be activated in the communications platform (to deactivate, ask your rel-
evant service personnel)).
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Making and Answering Calls

Answering Calls

The call display provides you with a convenient means of answering incoming calls. It con-
tains pull-down list boxes that display all pending external, internal and personal calls. You 
can selectively choose and answer any call.

Call Types

For a complete overview of all possible call types, see page 18. 
Examples:

• External: A call from a party outside your communications platform who has dialed the 
system number and operator number (such as 0) or whose call was not answered by an 
internal party (and PC AFT F is programmed as the intercept position).

• Internal: A call from another party to your communications platform.
• Private: A call from a party outside your communications platform who has dialed the 

system number and internal operator number (such as 100).

When you receive an incoming call, you hear a signal via the telephone speaker and/or the 
PC speaker (depending on the setting) and also see a display on the telephone screen (only 
if T-Octophon F or Octophon telephones are installed) and in the call display list box.

If you are working with another Windows application when a call is received, the sys-
tem automatically changes to the PC AFT F.
Note that the system cannot change to the PC AFT F while a screen saver is activat-
ed. In this case, the call is signaled by the speaker only.

A: 0891234567

I: 38041 Peters

P: 38559 Miller

List boxes:

Answer call

Open list box

External calls
Internal calls

Personal calls
Number of waiting calls
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Answering a call

 Left-click one of the handset buttons.
This accepts the first call waiting in the respective list field.

or

Click one of the arrows for the list box with the left mouse button to open the list and select 
the call that you wish to answer.

Answer the selected call.

or

Press the space bar on the keyboard.
This answers the first call in the queue, depending on the priority. The calls are prioritized as 
follows:
Recall - External calls - Internal calls - Personal calls.

The answered call appears in the traffic display:

Space Bar

When you answer a call, it makes no difference whether the telephone handset is on-
hook or off-hook because the telephone’s hookswitch is activated only during emer-
gency operation page 83 (not in conjunction with octoClient).
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Using Call Waiting (Second Call)

Answering a Second Call (Call Waiting)

While you are engaged in a call, you are also available to other callers. During the call, you 
are informed acoustically (by a call waiting tone if this tone has not been deactivated 

page 32) and visually (in the call display) that a second call is waiting. The call continues 
to be signaled in the call display until you have answered it.

1.

Terminate the current call with the "Clear" button.
The waiting call is indicated in the call display.

or

Click the Hold button to place the current call on hold page 48. The waiting call is sig-
naled in the call display.

or

Click the Park button to park the current call page 51. The waiting call is signaled in the 
call display.

2.

Accept the call.
You are speaking to the second caller.

or

Space Bar
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Activating/Deactivating the Call Waiting Tone

The call waiting tone lets you know that a second caller is trying to reach you while you are 
engaged in another call.

If the call waiting tone is deactivated, the "Camp-on without tone" message appears in the 
upper area of the traffic display. The waiting call (second call) continues to be signaled visu-
ally in the display.

Deactivating the Call Waiting Tone

Select the "Camp-on without tone on/off" menu item from the "Edit" main menu. 

The camp-on tone is deactivated and the  icon appears in the status bar.

Activating the Call Waiting Tone

Select the "Camp-on without tone on/off" menu item from the "Edit" main menu. 

or

 Left-click the icon in the status bar.

The camp-on tone is activated and the  icon goes out.

Picking up Calls

You can pick up calls for other telephones on your own telephone using the busy lamp field 
(not for stations in networked systems).
When a station is being called, the background of the status key turns (to set up the colors 
see page 93). 
You cannot pick up a call if you currently conducting a call or a call is being signaled in your 
call display.

You cannot pick up a call
• if the status key is displaying one of the busy states; in this case the destination party al-

ready picked up the call,
• if you are engaged in another call or
• If the call display is signaling a call

Prerequisite: The background or label of a status button in the busy lamp field changes color 
(e. g. yellow).

With the left mouse button, click the colored status button for the station being called.

The call is picked up and you can speak to the other party.

The communication platform can be configured in such a way, that when the 
PC AFT F is started up, the call waiting tone is automatically deactivated (ask rele-
vant service personnel).
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Activating/Deactivating the Ringer Signal

By connecting via USB or a control/data adapter you can deactivate the speaker on the sys-
tem telephone, and thus the ringer signal on the telephone receiving an incoming call. When 
the ringer signal on the telephone is deactivated, the telephone signals the call only visually, 
although you can have it signaled audibly using wave files (to activate wave files page 87 
and page 95).
PC AFT F can be configured so that the ringer signal for incoming calls is automatically de-
activated when PC AFT F starts up page 89. The "Mute on/off" message then appears in 
the menu window and the  icon appears in the status bar.

Deactivating the Ringer Signal

Select the menu item "Ringing on/off" from the "Edit" 
main window. 

The ringer signal is deactivated at the telephone and the  icon appears in the status bar.

Activating the Ringer Signal

Select the menu item "Ringing on/off" from the "Edit"
main window.

or

 Left-click the icon in the status bar.

The ringer signal is activated on the telephone and the  icon disappears from the status 
bar.
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Setting the Volume
You can change the volume of the handset speaker; in other words, you can select the vol-
ume at which you would like to hear the other party.

Prerequisite: You are making a call.

Click the volume button in the toolbar.

The menu window is displayed:

You can use the  and  buttons to set the volume at which you would like to hear the 
other party at any of eight different levels.

Activating/Deactivating the Microphone (Mute)

You can temporarily deactivate the microphone on your telephone handset or headset. If the 
microphone is deactivated, you can continue listening to the other party, but they can no 
longer hear you.

Prerequisite: You are making a call.

Deactivating the Microphone

Select the "Mute on/off" menu item from
the "Edit" main menu. 

or

Press the "F9" key (this must be programmed page 94).

The microphone is deactivated.

Activating the Microphone

Select the "Mute on/off" menu item from
the "Edit" main menu.

or

Press the "F9" key (this must be programmed page 94).

The microphone is activated.

F9

F9
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Actuating the Entrance Telephone Connection/
Door Opener

If a service technician has configured one or more entrance telephones, from your telephone 
you can speak to visitors using the entrance telephone and then you can activate the door 
opener. The entrance telephones are assigned internal station numbers.

Speaking to Visitors via the Entrance Telephone

Prerequisite: Your telephone rings and the entrance telephone station number appears in 
your call display.

Take the call within 30 seconds. You speak to the visitor on the entrance telephone.

or

Opening the Door

You can operate the door opener while engaged in a call with the entrance telephone or 
when your phone is idle.

Click the door lock button in the toolbar.

The following dialog box is displayed:

Enter the entrance telephone’s internal station number and click OK to confirm your entry.
Simply click OK if the entrance telephone number appears in the window while you are talk-
ing to the entrance telephone party.

The door is opened.

This function is not available network-wide page 84.

Space Bar
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Terminating a Call

One Party

or
Click the "Clear" button (= hanging up) or the "F3" key (must be configured page 94) to 
terminate your current call.

Two Parties

or
Click the "Back" button or press "F5" button (this must be configured page 94) to termi-
nate your current call and change to the waiting call.

If you are speaking to two parties alternately (toggling) or simultaneously (conferencing), you 
can interconnect the two parties by clicking the Connect button (the Clear button is replaced 
by the Connect button).
PC AFT F returns to idle mode and you can answer other calls again.

F3

F5
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Making Calls
Your PC AFT F attendant console allows you to initiate internal and external calls. When plac-
ing an external outgoing call, you also have the option of setting it up as a personal call. Such 
calls are specially marked during call charge evaluation so that they can be billed separately.

Making External Calls

Enter the external code and the external station’s number. The number is dialed as soon as 
you press Enter.

or

Enter the external code and the external station’s number. Then click the General button. 
The station number is dialed.

Personal Calls

Using the Private button, you can conduct external personal calls. These calls are specially 
marked for call charge evaluation.

Enter the external code and the external station’s number. Then click the Private button. 
The station number is dialed.

Outgoing external calls can automatically be identified by the length of the number 
to be dialed. If the number exceeds a certain length, the external code is prefixed au-
tomatically. To configure automatic external codes see page 95.

If you must dial the external code before dialing the external station number, the sys-
tem is programmed so that automatic line seizure is deactivated. In this case, the In-
ternal button does not appear in the attendant monitor. 
If automatic line seizure is activated, you do not need to dial the external code. How-
ever, for internal calls you must then click the Internal button before dialing.
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Turning DTMF Suffix-Dialing On and Off

While engaged in an external call, you can activate a sequence of digits to control answering 
machines or information and switching systems.

Select “Tone dialing” from the “Edit” menu or click the “Tone dialing” button.

or

A window for entering the DTMF digit sequence appears. Enter the digit sequence and click 
the "OK" button.

Making Internal Calls

Enter the number of the internal station and press Enter to confirm.

You can also dial the station from Outlook "Contacts" page 78, the busy lamp field 
page 39, or the repertory dial keys page 38.

Making Calls With Repertory Dial Keys

Use the repertory dial keys to call a station directly. If repertory dial keys have been config-
ured in PC AFT F page 89, the Repdial keys option appears on the menu bar.

Select the Repdial keys option from the menu bar to open a pull-down menu with the reper-
tory dial keys.

Select the name of the station that you want to call.
The station number is dialed.

You can program the system so that automatic line seizure is activated. It will then be 
unnecessary to dial the external code when placing external calls. 
However, you will then have to click the "Internal" button before placing internal calls. 
This button is displayed only if automatic line seizure is activated.

You can also store codes for controlling voice mail systems and answering machines 
on repertory dial keys.
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Making Calls With the Busy Lamp Field

Click the busy lamp field button in the toolbar.
The busy lamp field appears.

Idle State

You are not in the talk state and want to place a call.

With the left mouse button, click the status button for the station that you want to call.

Calling a Station

Left-click the status button of the station you want to call.

The station number is automatically dialed.

Calling a Substitute

Prerequisite: The station must already be assigned at least one substitute Page 25.

Right-click the desired station.
A popup menu with several functions opens.

Select "Substitute" from the popup menu.

In the Substitute menu, select the station number for the relevant substitute.
The station number is automatically dialed.

Switching State

You are engaged in a call and want to forward the call to a station in the busy lamp field. 
There are three ways to do this:

Screened transfer

With the left mouse button, click the status button for the station to which you want to transfer 
the call.

Wait until the destination station responds and announce the call.

Connect the station by clicking the Clear button.

Unscreened transfer

With the left mouse button, click the status button for the station to which you want to transfer 
the call.

Wait for the ring tone.

Connect the station by clicking the Clear button.
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Speed transfer

Right click the status button for the station to which you want to transfer the call. A popup 
menu with several functions opens.

Select the menu item “Speed transfer” from the popup menu. The call is immediately for-
warded to the selected station. If this station is busy, the busy station is automatically camped 
on after approximately five seconds (can be configured by the relevant service personnel). If 
the station cannot be reached, the call is signaled in the call display as a recall after approx-
imately forty seconds (can be configured by the relevant service personnel).

Making Calls With Redial

The last ten station numbers dialed are automatically stored. If the station you dialed is busy 
or unavailable, you can initiate a redial the next time you call instead of having to reenter the 
station number.

Click the redial button in the toolbar to open a pull-down menu with the last station numbers 
dialed.

Select the desired station number. 
The number is automatically dialed.

Double-clicking a status button has the same effect as single-clicking it.

By default, PC AFT F saves both internal and external station numbers. However, you 
can program PC AFT F to store only external station numbers in the redial list 

page 85.
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Making Calls with the Electronic Telephone Book

Prerequisite: the search in Outlook “Contacts” is deactivated page 93.

1.

In the “Name/Station number” entry field of the attendant monitor, enter the surname of the 
party you want to find in the traffic display and press “Enter” to confirm. If the name is saved 
in the Electronic Telephone Book page 80, it opens automatically displaying the match-
ing name.

or

Open the Electronic Telephone Book and highlight an entry.

2.

or If you want to call a user on his/her cellphone, for example, instead of via the default number, 
you can select this number from the “Station number” selection list, provided it is entered in 
the ETD page 74.

3.

or
Click the “Dial” button or confirm with “Return”. 

The station number is dialed.

For a detailed description of this function see page 73.

Making Calls From "Contacts" in Microsoft Outlook

Prerequisite: the search in Outlook “Contacts” is enabled page 93.

1.

In the “Name/Station number” entry field of the attendant monitor, enter the surname of the 
party you want to find and press “Enter” to confirm. If the name is stored in Microsoft Outlook, 
the Outlook search list window opens and the name(s) are listed.

2.

Using the left mouse button, double-click the line containing the required entry.

The number is dialed.

For a detailed description of this function see page 80.
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Consultation/Transfer/Conference

Transferring Calls

The following methods can be used to transfer an answered call to an internal or external sta-
tion. If you are unable to transfer calls to external stations, this is because you are not autho-
rized to do so (consult your relevant service personnel).
• Screened transfer: The person you are talking to would like to consult another party. Call 

the desired party and announce the call.
• Unscreened transfer: The person you are talking to would like to consult another party. 

Dial the number of the desired party, wait for the ring tone, and connect the two parties 
without announcing the call.

• Speed transfer: The person you are talking to would like to consult another party. Dial 
the number of the desired party and connected the two parties without waiting for the 
ring tone.

• Transfer after parking/holding: The external party you are talking to would like to consult 
another party. You place the call on hold or park the call. Dial the number of the wanted 
internal or external party, announce the call and then connect the two parties.
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Screened Transfer

1.

Accept the call.
The call appears on the traffic display.

or

2.

While engaged in the call, left-click the status button for the station to which you want to 
transfer the call. The system dials the number.

or

While engaged in the call, enter the number of the station you wish to reach and press Return 
to confirm. The system dials the number (you can also dial the party from Outlook “Contacts” 

page 78 or using repertory dial keys page 38.)

The two stations appear in the traffic display:
The first party is automatically placed on hold.

3.

s Wait until the destination station responds and announce the call.

4.

Connect the station by clicking the Clear button.

As soon as the stations are connected, their data is deleted from the traffic display and you 
are free to answer another call.

If the station is busy or does not answer, click the Back button to return to the first party.

Space Bar
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Unscreened Transfer

1.

Accept the call.
The call appears on the traffic display.

or

2.

While engaged in the call, left-click the status button for the station to which you want to 
transfer the call. The system dials the number.

or

While engaged in the call, enter the number of the station you wish to reach and press Return 
to confirm. The system dials the number (you can also dial the party from Outlook "Contacts" 

page 78 or using repertory dial keys page 38.)

Both stations appear in the traffic display.
The first party is automatically placed on hold.

3.

Wait for the ring tone and connect the station by clicking the Clear button.

As soon as the stations are connected, their data is deleted from the traffic display and you 
are free to answer another call.

If the third party is busy or does not answer, click the "Back" button to return to the first party. 
If the third party does not answer the transferred call within 40 seconds (time can be pro-
grammed by the relevant service personnel), the call appears as a recall in the call display.

Space Bar
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Speed Transfer

1.

Accept the call.
The call appears on the traffic display.

or

2.

While still conducting the call, use the right mouse button to click the status button for the 
station to which you want to transfer the call. The station number is dialed and the call is au-
tomatically forwarded to the station dialed.

If the party does not answer the transferred call within 40 seconds (time can be programmed 
by the relevant service personnel), the call appears as a recall in the call display.

Space Bar
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Transfer after parking/placing on hold

Prerequisite: You have placed an external call on hold page 48 or parked it page 51. 
The held/parked call is indicated in the call list.

1.

Click the left mouse button on the status button of the user whom you wish to call. The num-
ber is dialed.

or

During the call, enter the number of the internal or external party whom you wish to call, con-
firming your input with the "Return" button. The number is dialed. (You can also use Outlook 
"Contacts" page 78 or the repertory keys page 38 to dial this party.

2.

s Announce the call to the wanted party.

3.

Click the "Hold" button.

or

Press the "F4" button (this must be configured page 94).

4.

Double-click the left mouse button on the entry for the held/parked call in the traffic display.

Connect the station by clicking the Clear button.

As soon as the stations are connected, their data is deleted from the traffic display and you 
are free to answer another call.

F4
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Consultation Hold

You are conducting a call and want to obtain information from another internal or external 
party without the first party overhearing. If you are unable to transfer calls to external stations, 
this is because you are not authorized to do so (consult your relevant service personnel)

Prerequisite: You are making a call.

Enter the station number and press Enter to confirm your entry. 
The station number is dialed. 
(You can also dial the station from Outlook "Contacts" page 78, the busy lamp field 

page 39, or the repertory dial keys page 38.)

s When the station answers, you can conduct a consultation call. The first party is automatical-
ly placed on consultation hold, meaning that he or she cannot overhear your conversation.

When the other party hangs up, you automatically return to the party on hold.

Terminating Consultation Hold

Click the Back button to terminate the consultation and return to the waiting party.
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Hold

You can place external calls on hold whenever you want, for example, to call another station.

Placing External Calls on Hold

Prerequisite: You are currently conducting an external call.

Click the "Hold" button.

or

Press the "F4" button (this must be configured).

If configured, page 95 you can enter any text for the party to be placed on hold under 
"Name / Station number" (field becomes green). You can still speak with the caller while en-
tering the text.
Confirm the input.

The other party is placed on hold and cannot listen in. The held call is indicated in the call list.

Click the Clear button. You are now available to answer other calls.

You can also place more than one external call on hold.

Activating a Held Call

Prerequisite: You are not engaged in a call.

Using the left mouse button, double-click the line in the call list which contains the held call 
you wish to take.
You are reconnected to the held party.

Internal calls cannot be placed on hold.
They can, however, be placed on consultation hold page 47 or parked 

page 51.

F4
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Toggle

The toggle function allows you to alternate between two calls. The station currently waiting 
cannot overhear your conversation. 

Prerequisite: You are currently conducting a call and another party is 
waiting (for example, on consultation hold).

Click the Toggle button to change to the waiting party. 

or

Press the "F6" button (this must be configured page 94).

You change to the waiting party.

Interconnecting Two Parties

Click the Clear button to interconnect the two stations.

Set up conference

You can set up a three-party conference between yourself and the other two parties by click-
ing the "Set up conference" button page 50.

F6

You cannot activate the toggle function if you used the Hold button to place one of 
the two parties on hold.
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Conference

You can add another party to an existing call to form a three-party conference in which all 
three parties can speak to one another.

Prerequisite: You are currently conducting a call and another party is waiting (for example, 
on consultation hold).

Click the "Initiating conference" symbol command button.

or

Press the "F10" button (this must be configured page 94).

The message Conference is displayed in the status box for both parties. The three-party con-
ference is initiated.

The  icon appears in the status bar.

Terminate conference

 Left-click the icon in the status bar.

All conference members are then disconnected and the  icon disappears from the status 
bar.

Click the Clear button to leave the conference; the other two parties remain interconnected.

F10

You can also initiate the conference after toggling (several times) page 49.
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Park

You can park a call that you have answered but have not forwarded. The parked call can be 
connected to another party page 46.
Your PC AFT F can be configured so that a waiting call automatically places the current call 
on hold. For more information on this capability, please get in touch with your relevant ser-
vice personnel.

Prerequisite: You are currently conducting a call. 

Click the Park button to park the call. 

or

Press the "F7" button (this must be configured page 94).

If configured, page 95 you can enter any text for the party to be parked under "Name / 
Station number" (field becomes green). You can still speak with the caller while entering the 
text.
Confirm the input.

The parked call is shown on the call display. The PC AFT F automatically parks the call in the 
next available park slot.

Each telephone system has park slots for ten calls, which both you and other internal parties 
can park.

Answering Parked Calls 

Prerequisite: You are not engaged in a call. 

Using the left mouse button, double-click the line in the call list which contains the parked 
call you wish to take.
You are reconnected to the held party.

The parked call disappears from the call display.

F7

If calls simply "disappear" from your parking list, they may have been answered by 
other internal parties.



Consultation/Transfer/Conference

52

Overriding Calls

If an emergency arises and you must speak to a busy internal station, you can break into the 
busy station’s call and speak to the party. You will then hear an alerting tone.

In order to prevent parties from breaking into existing calls undetected, the message “Over-
ride: ...“ appears on the display of the telephone involved and the parties are reminded every 
two seconds by a dual tone that they are in an override situation.

1.

Dial the internal station number. You hear a busy signal. As soon as you heard the ring tone 
you are camping on at the other station.

2.

Click the override button in the toolbar. 
You can now speak with the two parties.

or

Press the "F8" button (this must be configured page 94).
You can speak to both parties.

Click the Clear button to leave the call. The other parties remain interconnected.

Overriding Do Not Disturb

Prerequisite: You are authorized to override do not disturb (can be configured by relevant ser-
vice personnel).

You urgently need to reach an internal station that has activated do not disturb.

Dial the internal station number. You hear a busy signal. After a brief wait, the system auto-
matically overrides do not disturb. You hear a ring tone and the destination telephone starts 
ringing.

This function is not available network-wide page 84.

F8

This function is not available network-wide page 84.
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Station Number Display Suppression

You can prevent the attendant console’s station number or name (for example, Switchboard) 
from appearing on the called party’s display (not for internal calls). 
You must activate this display suppression before dialing; it then remains activated until you 
cancel it.

Activating Display Suppression

Select the "Privacy on/off" menu item from the "Edit" main menu or click the “Privacy on/off” 
button.

or

The  icon appears in the status bar.

If you now call external party, neither the station number nor the name of the attendant con-
sole will appear on his or her display.

Deactivating Display Suppression

Select the "Privacy on/off" menu item 
from the "Edit" main menu.

or

 Left-click the icon in the status bar.

The  icon disappears from the status bar.

The next time you place an external, your station number or name will appear on the called 
party’s display.



Reaching Parties More Effectively

54

Reaching Parties More Effectively

Automatic Callback

When you cannot reach specific parties, you can send them callback requests to save your-
self from attempting additional calls.

1.

Enter the station number and press Enter to confirm your entry. 
The station cannot be reached.

2.

Click “Activate callback“in the toolbar.
The  icon appears in the status bar.

Your callback request is sent to the called station.

The system automatically calls back when:
• The called party hangs up.
• The called party returns and has conducted a call.
• The called party displays his or her messages and responds to the callback request.

When you answer the callback, you first will hear a dial tone and then the other party will be 
called.

You can store up to ten callback requests.
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Displaying and Canceling Callback Requests

You can display and cancel callback requests that you have already issued.

Click the "Menu Window" toolbar button.

or

 Left-click the icon in the status bar.

The menu window is displayed.

Using the ,  and  buttons, you can retrieve and cancel the callback re-
quests.

The  icon disappears from the status bar.

Using the  button in the menu window, you can cancel the input and close the window.

Paging

You can issue a speaker announcement to specific groups through your telephone. These 
groups can be made up of telephones and speaker systems; they are configured and as-
signed group numbers by the relevant service personnel. These group numbers must be set 
to "active" mode in the PC AFT F page 88.

Select the Paging option from the menu bar to open a pull-down menu with the paging 
groups.

Select the group that you want to page. 
The group number is dialed automatically. You can now make your announcement.

This function is not available network-wide page 84.

The Paging menu option appears in the menu bar only if paging groups have been 
activated in the Settings window.



Reaching Parties More Effectively

56

Speaker Call

You can record an announcement without any assistance via connected loudspeakers (ask 
relevant service personnel) or at an internal station with access to a system telephone.

Click the “Speaker call” button. 

The following dialog box is displayed:

Enter the number of the station to which you want to directly speak and click “OK” to confirm 
your entry.

The station is automatically dialed and you can then speak immediately 

This function is not available network-wide page 84.
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Messages

Sending a Message

You can send info texts to individuals or station number groups with system telephones. Info 
texts sent to system telephones without a display (for example, T-Octophon F 10), ISDN, im-
pulse or tone dial telephones are saved as callback requests.

Click the message button in the toolbar.

The following dialog box is displayed:

Enter the number of the internal station or group to which you want to send a 
message and click OK to confirm your entry.

The menu window appears.

Messages can also be sent to stations in networked systems.
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Using the ,  and  buttons, you can select from among ten predefined, 
brief messages, or enter a separate text:

0 = Please callback
1 = Someone is waiting
2 = Appointment 
3 = Urgent call
4 = Do not disturb
5 = Fax waiting
6 = Dictation please
7 = Please come see me
8 = Please make copies 
9 = Ready to depart
Enter other text

The number and content of the brief messages listed here may differ from the messages ac-
tually stored in your system.

If you selected “Enter other text" you can enter any text. Click the  button to open the text 
input window and enter a text.

As soon as you confirm the option “Send“ in the menu, the message is sent.

Using the  button in the menu window, you can cancel the input and close the window.
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Display/Delete Sent Info

Click the “Menu Window” button.

The menu window is displayed.
Scroll down using the  button to “Sent message” and confirm with .

The ,  and  buttons enable you to view the sent messages and the time 
at which they were sent, and delete these messages.

The  button in the menu window enables you to cancel the display and close the window.
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Receiving a Message

If messages are waiting for you, these appear in the menu window.
These are signaled by the "message“  icon in the status bar.

Click the "Menu Window" button.

or

 Left-click the icon in the status bar.

The menu window is displayed.

Using the ,  and  buttons, you can view the messages received, call the 
sender and delete the message.
If there are no further messages in the list after deletion, the  icon disappears from the 
status bar.

Using the  button in the menu window, you can cancel the input and close the window.

Transferring an External Trunk

If configured, you can transfer an external trunk to an internal user who is not authorized to set 
up outgoing external calls, thus enabling this party to set up an external call independently.

Prerequisite: You are talking to a party who does not have direct trunk access.

Click the Transfer trunk button.

Click the Clear button. You are now available to answer other calls.

Texts sent to groups can only be deleted by the sender.

This function is not available network-wide page 84.

Parties without direct trunk access must enter the external code before dialing an ex-
ternal number.
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Releasing an External Trunk

You want to place an urgent external call and receive a busy signal because no external trunk 
is available. You can select a busy trunk and disconnect the call on this trunk to make the 
trunk available for your call.

Keep in mind that this function disconnects calls in progress and should be used only in dire 
emergencies.

Releasing a Busy Trunk

You wish to dial an external station number but already hear a busy signal before you dial.

Click the release trunk icon in the toolbar.

The menu window appears.

Using the ,  and  buttons, you can select and release an external trunk.

Using the  button in the menu window, you can cancel the input and close the window.

Now enter the station number and press Enter to confirm your entry. The station is dialed via 
the released trunk.

This function is not available network-wide page 84.

If your system is not configured for releasing an external trunk, the release trunk but-
ton will not appear in the toolbar.
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Radio Paging (PSE)

If you call an internal station and cannot reach the party at his or her workstation, you can call 
the absent party using the radio paging equipment.

Prerequisite: Radio paging must be programmed in the system.

Select the "PSE" menu item from the "Edit" main menu.

The following dialog box is displayed:

Enter the desired party’s station number (for example, his or her pager number) and press 
Enter to confirm your entry.

The menu window appears.

Using the ,  and  buttons, you can enter a message (for example, a sta-
tion number) for the party and page this party.

Using the  button in the menu window, you can cancel the input and close the window.

If the party paged does not respond or if the radio paging equipment shuts off after a certain 
period of time, you can cancel the page by clicking the Clear button.

This function is not available network-wide page 84.
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Forwarding Calls

You can forward both internal and external calls to various destinations (internal or external 
telephones) (whether external destination is possible depends on system configuration).

Activating Call Forwarding

Click “Activate call forwarding“in the toolbar. 

The following dialog box is displayed:

Enter the station number of the call forwarding destination (internal or external telephone) 
and click OK to confirm your entry.

Call forwarding is activated and the  icon appears in the status bar.

Deactivating Call Forwarding

 Left-click the icon in the status bar.

Call forwarding is deactivated and the  icon disappears from the status bar.
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Night Answer

Night answer is activated when your attendant console is unattended (for example, when the 
office is closed). External calls are forwarded to an internal night destination (such as the se-
curity officer) that you select. The service personnel can configure whether or not the 
PC AFT F will be authorized to activate night answer.

You can enter and select from among up to eight different internal night destinations.

Entering a Night Destination

From the File menu, select the Settings option to open the Settings 
window.

Select the Night destinations tab.

Enter the possible internal night destinations in the text boxes.

Click the OK button to confirm your entries.

Click the Cancel button to return to the attendant monitor.

To select a night destination, click "Change night dest." in the Edit menu page 65 and 
click the Night service button to activate it page 66.

This function is not available network-wide page 84.
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Selecting a Night Destination

You can select which night destination (from among up to eight internal night destinations) 
will answer incoming calls. To do this, either select a predefined night destination 

page 64 or enter one manually.

Predefined night destination

Select “Change night dest.” from the “Edit” menu. The following pull-down menu appears:

Select a night destination. The night destination selected is identified by a check mark. 

After you activate the night service page 66, all calls are forwarded to this night destina-
tion.

Entering a night destination manually

Select the "Change night dest." from the "Edit" menu. The following pull-down menu ap-
pears:

Select the "Manual input" option.

The following dialog box is displayed:

Enter the night destination number and click OK to confirm.

To select the night service programmed in the system by the service personnel, enter an as-
terisk (*) for the night destination.

After you activate the night service page 66, all calls are forwarded to this night destina-
tion.
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Activating Night Answer

Click the "Activate night answer" icon in the toolbar. 

Call forwarding to the night destination is activated and the  icon appears in the status 
bar.

Deactivating Night Answer

 Left-click the icon in the status bar.

Call forwarding to the night destination is deactivated and the  icon disappears from the 
status bar.

You must still answer any waiting calls in the call display. Any new calls are forwarded 
to the night destination.
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Notebook
The Notebook function opens the "Editor" program in Windows.

Opening the Notebook

From the Window menu, select the Notebook option.

The Editor is displayed.

You can save, open and print the notebook files via "File" in the Editor menu. 
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Call Detail Recording for Individual Calls

When a party using an internal telephone (one that is accessible to the public, such as a pay 
phone) terminates a chargeable call, the call charges can be displayed on the PC AFT F con-
sole.
However, the service personnel must have configured the "pay phone" function in the sys-
tem.

Click the "Callbox" button.

The menu window appears.

Using the ,  and  buttons, you can select the internal station and display, 
print or delete the call charges incurred and the call duration.

Using the  button in the menu window, you can cancel the input and close the window.

This function is not available network-wide page 84.
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Programming/Changing Repdial Keys
You can program the station numbers or codes you use the most on the ten repertory dial 
keys. A sequence of codes can be used to control a voice mail system or an answering ma-
chine or activate functions on the communications platform (such as entering "#82" to dis-
play the caller list).

From the File menu, select the Settings option to open the Settings window.

Select the Repdial keys tab.

In the text boxes, enter the names and station numbers of the stations desired or codes.

Click OK to confirm your entries.

Click the Back button to return to the attendant monitor.

You can now reach your parties directly via the repdial keys.

From the menu bar, activate the Repdial keys menu page 38 to access the pull-down 
menu with the repdial keys.

The Repdial keys option appears in the menu bar only if you have configured reper-
tory dial keys in the Settings window page 89.
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Use Caller List
The caller list displays all incoming calls (answered and unanswered) in a chronologically 
sorted list. You can use this list to conveniently return calls and delete entries from the list.

Click the “Caller list” button. It opens the “Caller list” window.

The list is sorted in chronological ascending order, for example, the most recent calls are lo-
cated at the end of the list. If the entries do not fit in the list window, a scroll bar appears to 
view the complete list.

Click on the “Close” button to close the window.

Return Calls

Using the left mouse button, double-click the line containing the required entry.
The station number is dialed.

The list window can only be displayed if entries are found in the list.

Date of call

Scroll bar

Caller station number

Time of call
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Delete Individual Entries

Highlight some list entries by clicking and dragging.

or

Add individual entries to those highlighted or delete individual entries from your selection.

Click “Delete Selected Entries” in the list window.
The selected entries are deleted without requesting confirmation.

Delete Entire List

Click “Delete List” in the list window.
The entire list is deleted without requesting confirmation and the list window is closed. 

Ctrl +
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Electronic Directory (ETD)
The electronic directory provides you with a convenient means of searching for stations and 
dialing the numbers. You can also display detailed information on the stations. 
In the default configuration, a database for the ETD is loaded when the PC AFT F is started up.

Starting the ETD

To start the ETD, select the Directory option from the Window menu.

or

Click the directory button in the toolbar.

The main window of the directory is now displayed containing all the stations in the directory 
with their data.

Record

Edit 
Record

Data fields

Generate new record Provide station number 
for dialing

Return to 
Attendant Moni-
tor
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Searching for a Station

You wish to call Mr. Adams. However, you do not know Mr. Adam’s station number.

Prerequisite: the search in Outlook “Contacts” is deactivated page 93.

Enter the first few letters of the name of the party you want to find in the “Name/Station num-
ber” entry field of the attendant monitor (for instance, “Ada”) and press “Enter” to confirm. If 
the electronic directory contains the combination of initial letters entered, it automatically 
opens the telephone book with the matching entries.

The first station name in the ETD that matches the initial letters entered is highlighted. Select 
the desired station.

Click the Dial button.
The saved station number is dialed
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Adding New Stations

In the directory’s main window, click the New entry button to open another window that has 
two different tabs on which you can enter a new station in the ETD.

The window contains the two tabs “General” and “Additional”. On these tabs you can enter 
additional data for the station.

General

On the “General” tab you can enter the user’s name, company, address and various tele-
phone numbers.
When calls are made by way of the telephone directory page 41, the number is displayed 
in the “Station number” field (default setting) and then dialed. The four other possible num-
bers can then also be selected.

Save record
Return to main direc-
tory window

General tab Additional 
tab
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Additional

You can use the “Additional” tab in order to enter further data, for example the user’s depart-
ment or corporate rank or several lines of notes, e.g. details of the company’s business hours.

Click the save icon to save the data.

Click the “Close” button to return to the main directory window page 80. The new station 
and its data are displayed here.

Click the “Close” button in the main directory window to exit the ETD and return to the atten-
dant monitor.

If you click the “Close” button without saving the record, the record is automatically 
saved and you are returned to the directory’s main window.
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Editing an Entry

Click the Edit button in the directory’s main window to open another window with two differ-
ent tabs on which you can modify the information for the selected party.

From the directory’s main window, select the party whose entry you would like to modify.

Click the “Edit” button.
Another window is displayed with two different tabs on which you can modify the party’s data.

Click the save icon to save the data.

Click the “Close” button to return to the main directory window page 80. The new station 
and its data are displayed here.

Click the “Close” button in the main directory window to exit the ETD and return to the atten-
dant monitor.

Return to main direc-
tory window

Save record

If you click the “Close” button without saving the record, the record is automatically 
saved and you are returned to the main directory window.
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Delete Entry

Click the “Edit” button in the main directory window to open another window with which you 
can delete the entry.

From the main directory window, select the party whose entry you would like to delete.

Click the “Edit” button. 

Delete the entry with “Delete”.

Confirm your request with “Yes”.

Click the “Close” button in the main directory window to exit the ETD and return to the atten-
dant monitor.

Delete record
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Telephone Book Function with 
Outlook "Contacts"
The telephone book function provides you with a convenient means of searching for stations 
and dialing the numbers. The Microsoft Outlook "Contacts" folder is used as a data source 
for this.

Searching for a Station

You wish to call Mr. Adams. However, you do not know Mr. Adam’s station number.

Prerequisite: the search in Outlook “Contacts” is enabled page 93.

Enter the first few letters of the name of the party you want to find in the traffic display in the 
"Name / Station number" entry field of the attendant monitor (for instance, Ada) and press 
Enter to confirm. If "Contacts" in Microsoft Outlook contains the combination of initial letters 
entered, the "Outlook search" list window displaying the search results is automatically 
opened.

The first station name that matches the initial letters entered is highlighted. Select the desired 
station.

Using the left mouse button, double-click the selected line.

or

Please note:
• Microsoft Outlook Express is not supported.
• Canonical format is supported.
• Special features must be taken into consideration regarding the format of the 

contact name in Microsoft Outlook page 102.
• Only the entries in the Outlook “Contacts” folder are used when running search-

es in Microsoft Outlook. Sub-directories are not searched.
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Press Enter.

or

Right-click the selected line if you wish to call a user on his/her cellular phone, for example, 
instead of via the default number.

If several numbers were entered in the ETB for the same user, a pop-up menu appears. Se-
lect the required number from the menu.

The number is selected.

When you search for a station, the first 100 records located are displayed. If you do 
not see the station you are looking for, enter a more specific search word.
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Searching on the Basis of Other Station Data

You can also base a search on other data such as a company name, city or postal code. The 
example below uses a company name. 
A search by city or postal code is conducted in a similar manner.

Click the “Outlook” button. The following popup menu appears:

Select the desired property from the menu which will be used in the search, for example, 
“Company”.

The following dialog box is displayed:

Enter the company desired and click OK to confirm your entry.

If the company is stored in "Contacts" in Microsoft Outlook, the "Outlook search" list window 
opens with a list of the parties employed by this company. The first party is highlighted.

Updating Telephone Book Data

To enter new data or modify existing station data in the Microsoft Outlook "Contacts" folder, 
please refer to the Microsoft Outlook documentation.
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Searching the Telephone Book
This function searches for names and phone numbers in the telephone book.

1.

Click the “Telephone Book” button. 

or

Select the "Search the telephone book" menu item from the "Window" menu.

or

Press the "F12" key.

The "Search the telephone book" window opens.

2.

Enter a name. You can also enter part of a name, for example "mil" for "Miller". The search 
function is not case-sensitive. Confirm with "OK". 

3. If one or more entries are found, these are displayed in the menu window. 

Using the  ,  and  buttons, you can select and call a station.

Using the  button in the menu window, you can cancel the input and close the window.

This function must be supported by your communications platform. Please ask your 
service pesonnel to activate this function.

F12



Starting the telephone directory CD

82

Starting the telephone directory CD
A telephone directory CD can be started by way of the "telephone directory CD" button in the 
main window of the PC AFT F.
The precondition is that the telephone directory CD has been integrated into PC AFT F.
Integration of the telephone directory CD function, see page 93.

Operation of the telephone directory CD varies according to the telephone directory CD soft-
ware which is used.
In order to use the telephone directory CD, please read the documentation supplied with the 
telephone directory CD software.

Using a number on the telephone directory CD

The number located on the telephone directory CD is transferred by copying it and then en-
tering it in the traffic display of the PC AFT F.

Use the mouse to mark the wanted number in the telephone directory CD program.

Press "Ctrl" and "C" to place the data in temporary storage.

Position the cursor in the "Name / Station number" field in the switching area.

Press "Ctrl" and "V" to copy the data from temporary storage to the traffic display.

Ctrl + C

Ctrl V+
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Opening search window for LDAP server
The search function within the LDAP server is activated with the "Search window for LDAP 
server" button in the main window of the PC AFT F.

The precondition is that this search function has been integrated in the PC AFT F. To activate 
this search function, see page 93.

Emergency Operation
When you exit the PC AFT F or in the event of an application failure, the PC AFT F changes 
over to emergency operation. All the features of your telephone system are retained and you 
can continue to execute all switching functions from your T-Octophon F or Octophon system 
telephone (not in conjunction with octoClient).

To return to your PC attendant console, restart the PC AFT F program page 13.

Please note:
• Canonical format is supported.
• Names are only searched for in the “Surname” field in Microsoft Active Directory 

Server.

This search function uses your PC operating system functions which are only avail-
able after an update under Windows®98 and Windows®NT.
Please get in touch with your system administrator to update your operating system.
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Special Functions in the LAN (PC Network)
If your PC AFT F is operating in an IP network from T-Octopus F 200/400/600/650 /
IP Netpackage systems, multiple communications platforms are interconnected via a LAN (Local 
Area Network, e.g. proprietary PC network). Your telephone calls are conducted via the LAN (PC 
networks).

Busy Lamp Field

It is not possible to set station names and numbers network-wide. Station names and num-
bers outside the local number plan must be entered manually page 24.

Additional Special Features

The following functions are not available network-wide:
• Door Opener page 35
• Overriding Calls page 52
• Overriding Do Not Disturb page 52
• Paging page 55
• Speaker Call page 56
• Transferring an External Trunk page 60
• Releasing an External Trunk page 61
• Radio Paging (PSE) (Not for U.S.) page 62
• Night Answer page 64
• Call Box page 68

Configuring the PC AFT F
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Entering Settings
The settings that can be activated in the PC AFT F "Settings" window are described in this 
section. 
For further settings see page 92.

System

In the "System" directory, you can specify the connection type, activate the settings for the 
busy lamp fields (BLF) and activate general settings for the attendant console.

Connect to: 

Select the PC interface for the following connection types in the selection list field:
• Control/Datenadapter: "COM 2" or "COM 1"
• USB: "COM 3"
• octoClient: "IP"

System Update 

Data relevant to PC AFT F, such as the local call plan for example, are transferred from the 
system to the PC via the "System Update" key.

Whenever a change is detected in the system configuration after start of the 
PC AFT F or during its operation, the PC AFT F is automatically updated. This proce-
dure is indicated in the status bar by the message “Please wait.”
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Set BLF  

The "Set BLF" key allows you to transfer user data from the local call plan (your system’s 
users) to a busy lamp field.

Prerequisite: A call plan was loaded using "System Update" page 85 and at least one BLF 
is displayed page 22.

Click the "Set BLF" key. 
A list window displaying the current user data opens automatically.

Highlight some or all of the list entries by clicking and dragging.

or

Add individual entries to those highlighted or delete individual entries from your selection.

Click a highlighted list entry, holding down the mouse button, drag the entry to the specific 
BLF status key after which you want to transfer the selected entries (a "+" icon appears at the 
mouse cursor). 

The highlighted entries are transferred to the BLF once you release the mouse button.

Stations from networked systems can only be entered manually page 24.

To move status buttons on the BLF see page 25.

Ctrl +

Highlighted entries

BLF

List window

Transferred
entries
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Number redial only for external numbers

This option allows you to restrict the number redial list to external calls.

Deactivate night answer at start

If you select this option, night answer is automatically deactivated (if it was previously activated) 
when the PC AFT F is started.

Activate silent call at start

If you select this option, the ring tone is automatically deactivated when starting PC AFT F 
(only in the case of connection via USB or a Control/Datenadapter).

Call Detail File

This option (cannot be changed in PC AFT F) displays whether all chargeable calls with their 
values are to be saved in a call detail file.
Contact your service personnel to set up this function. The call detail file is stored in the in-
stallation directory of PC AFT F.

Calls

In the other text boxes under this tab, specify the paths to the wave files (included in the soft-
ware package) for ringer signaling on the PC. You can also assign individual Wave files with 
the "..." key and play them back with the speaker key. This must be activated for call signaling 
via wave files page 95.

External station numbers can be identified by the number of digits. The number of 
digits can be configured page 95. Ensure that you configure the trunk access 
code correctly page 95.
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Paging

Under the Paging tab, you can configure the existing groups in the communication system 
as active announcement groups. 

From the Existing groups box, select the groups that you want to be able to reach with a 
speaker announcement and transfer them to the Active announcement groups box.

“Paging” is now displayed as a menu option in the PC AFT F menu bar. This menu option 
allows you to issue speaker announcements to the configured groups.
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Repdial Keys

Use the "Repdial keys" tab to program the ten station numbers or codes you use the most on 
repertory dial keys. A sequence of codes can be used to control a voice mail system or an 
answering machine or activate functions on the communication server (such as entering 
"#82 to display the caller list).

In the input fields, enter either the name and station number of the station your wish to reach 
or the name and code for controlling a voice mail system or answering machine.

The Repdial keys menu option is now displayed in the PC AFT F menu bar. This option provides 
you with a pull-down menu from which you can call the configured stations and access the con-
figured functions directly.
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Night Destinations

In the “Night destinations” tab you can enter up to 8 different internal night destinations. 
From the “Edit” menu with the “Change night dest.” menu item, you can select a night desti-
nation and activate it via the “Night answer” button.
 All calls are forwarded to this destination.
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Saving the Settings

Once you have entered your settings in the Settings window, you must save your entries in 
order for the changes to be applied.

In the Settings window, click OK to confirm your entries.

When you return to the attendant monitor, the message Please wait may appear in the status 
bar of the attendant monitor while PC AFT F is being updated with the new settings. As soon 
as the update operation has been completed, the message System ready is displayed. The 
PC AFT F is ready for operation.

Click the Back button to return to the attendant monitor without save the changes.
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Configuration Manager
This program can be used to activate additional settings not available under "File" - "Settings" 
for PC AFT F.

Starting Configuration Manager

Click the “Configuration Manager” button in the toolbar. 
The Configuration Manager is opened.

PC AFT F must be restarted in order for the changes to some functions to be applied. 

To apply changes to BLFs page 93, you must simply activate them via the  
key.

Menu bar

Transfer button Configuration area

Menu tree
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Entering Settings

Telephone Book

To run a search in a Telephone book CD page 82, enter the complete path to a telephone 
book program under "CDROM Telephone Book" or select an executable file via "...".

To run a search on the LDAP server page 83, enter a valid IP address or specify the name 
of the LDAP server under "LDAP Server".

Activate “Use MS Outlook as telephone directory” in order to use the “Contacts” folder from 
the Microsoft Outlook program as a data source when searching in the “Name/Call number” 
entry field of the attendant monitor page 78. 
If this box is not checked, the ETD is used instead as a database for the search page 73.

Busy Lamp Field

Double-click the “Busy Lamp Field” entry with the left mouse button to show/hide its sub-
menus.

Colours of BLF

You can determine the colours to be used for signaling the various line statuses of the status 
keys on the BLF here page 21.

Click the key beside the status whose colour you wish to change. A colour selection dialog 
appears.
You can select one of the predefined colours by clicking it or alternatively you can mix your 
own colour.
Click "OK" to confirm.

Experience in configuring IP networks is required for certain settings. Please contact 
your relevant service personnel for further information.
Incorrect configuration can result in the failure of important PC AFT F functions.
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BLF Configuration

The following settings can be performed for each of the three available BLFs page 21.

Enter the text that should appear in the title bar of the relevant BLF in the "Text for the BLF" 
field.

Specify how many status keys the BLF contains in the selection list field. You can select 20 
to 240 status keys (number specified in multiples of 20).
Up to 140 keys can be selected in Name mode.

Activate "Display name" if you want the name to appear directly on the status key (Name 
mode). The names must be available for this.

If you activate "Display BLF" the relevant BLF is visible and is automatically displayed when 
starting PC AFT F. Configuration and key assignment are not deleted if the BLF is deactivat-
ed.

Function Keys

You can select the assignment of function keys on your PC keyboard.

Select a function key from "F1" to "F10". 
For standard key assignment see page 108.

The availability of the "Station is diverted" and "Do not Disturb is active" functions de-
pends on your version of the communications platform.
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Incoming and Outgoing Calls

• "Do not change focus on incoming call"
Here you can specify if PC AFT F is automatically displayed on top if multiple Windows 
programs are open.

• "Text input in Hold and Park"
Here you can specify if a window for entering text should be displayed when placing a 
station on hold page 48 or when parking page 51 a station.

• "Wave file activated"
Here you can specify if the configured wave files page 87 should be audible for call 
signaling.

• "Deactivate automatic hold with clear key"
Activate this function if simplified hold (hold without end key) is configured in your com-
munications platform.

• "Show the caller destination number"
Activate this function so that in the case of incoming calls which are not for you, the num-
ber of the station which the caller wanted to reach is entered in the field "call number/
name" (the call number can then be directly dialed with "Enter").

If automatic line seizure is not activated for the communications platform (contact System 
Support):
• you can specify which codes can be prefixed for external calls (e.g. "0") in the "Extend 

trunk" field.
• you can activate automatic external code prefixing for trunk seizure from the specified 

number of digits by entering a station number length.
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Connection via IP

The following information is required for connection via IP (with octoClient).

Enter a valid IP address for the T-Octopus F LAN gateway in "IP Addresse HG 1500" 
(if available).

Enter the station number and password for reaching the PC AFT F via IP in the relevant fields.

Under "Mixer device used", select the sound mixer to be used for audio signals on the PC.

Under "Recording device used", you can select the device installed on the PC which is to be 
used for audio recording on the PC.

Under "Output device used", you can select the device installed on the PC which is to be 
used for audio playback on the PC.

Activate the function "Use the USB phone headset" if you want to conduct conversations via 
the USB phone headset.

Checkmark “USB phone” if your USB phone is a Siemens product.

Connection for Braille Console

The following information is required for connecting a braille console.

From the selection list field, select the interface for the braille console (“Com 1" to "Com 4") 
and check the “Active” checkbox if the console should be activated via the selected inter-
face.
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Statistics

The statistics function contains information on all incoming calls.

If the entries do not fit in the list window, a scroll bar is displayed to view the entire list.

Change display

Change column width:

To change the column width, click on the edge of a column (mouse pointer changes to a dou-
ble-headed arrow) and drag the edge to the left or right by pressing and holding down the 
mouse key.

Change sort sequence:

Left-click the top of the column whose sort sequence (ascending or descending) you want 
to change.

Reset statistics 

You can delete the statistics list. The empty list will then be filled up again with subsequent 
incoming calls.

Click the “Reset” button. The contents of the list are deleted without requesting confirmation.

Type of call (see Call Types page 18)
Caller station number

Name of the caller

Destination station number
Date of call

Time of call

Reset button
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Licensing

The following specifications are necessary for CLA licensing.

Under "IP address of the License Agent (CLA)", specify the IP address of the license agents.

Under "License Agent port (CLA)", specify the port number of the license agents.

For further information on licensing, please contact your service personnel.
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Saving Settings

You must save your entries in order for the changes in Configuration Manager to be applied.

Click "Transfer" to confirm changes.
Click “OK” to confirm the message in the dialog box.

Error Correction in PC AFT F

The “Transfer” button is only active if at least one modification was made in the Con-
figuration Manager.
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Error Correction in PC AFT F
This section discusses possible solutions to problems that may arise when operating PC AFT F.

Startup Problems

The PC AFT F does not start correctly

• Check whether you have too many other programs open.
• Shut down your computer and switch it off and on.
• If the problem persists, uninstall the PC AFT F software and then reinstall it (see the 

PC AFT F CD-ROM CD booklet).

A licensing error is displayed at startup.

• Ensure that the license agent (CLA) is available on the PC.
• Check the Configuration Manager settings with respect to the CLA data page 98.

For further information on licensing, please contact your service personnel.

Operating Problems

The PC AFT F is no longer responding

• Close any 16-bit applications that are open (such as Word 6.0).
• Check whether the system is still operating by verifying another telephone’s operation 

(the system may have failed).
• Shut down your computer and switch it off and on.

"Please wait" is permanently displayed on the status bar

• For Octophon telephones: 
Check the cable to ensure that the connection between the system telephone’s Control/
Datenadapter and the PC has been established.

• For T-Octophon F telephones: 
Check the USB cable to ensure that connection between the system telephone’s USB 
port and the PC has been established.

Once the system is correctly connected, the message disappears and the PC AFT F is again 
ready for operation.
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The Busy Lamp Field is malfunctioning

• If the status button for a station is always red (indicating that the station is busy), it may 
not mean that the station is constantly conducting calls but, instead, that the station te-
lephone is defective or was removed from the communication system. If such is the ca-
se, update the busy lamp field page 85 and page 86.

• If the status button for a station is always yellow (indicating that the station is being 
called) and you cannot transfer the call, it may mean that you are conducting a call or 
that you have a call waiting. In such cases, you cannot transfer the call.

Existing Outlook contacts are not displayed as a search result

Searches for a name in Outlook "Contacts", PC AFT F are only performed in the "Surname" 
field.

It is therefore necessary to enter the sequence "Surname First name" when adding a contact, 
as otherwise the default settings in the Outlook contact options will save an entry such as 
"Hofmann" as a "First name".

Solution

Change the default contact options settings in Outlook.

To do this, open "Extras" - "Options" - "Settings" - "Contact options" in the Outlook menu and 
change the name sequence to "Surname First name" .

Troubleshooting Using the Trace Button 
(Service Personnel Only)

The trace button allows you to store special error codes for reproducible errors in a text file 
that can then be passed on to a service technician at Deutsche Telekom AG (intended for re-
levant service personnel only).

Configuring the Trace Button
• In the PC AFT F root directory, open the config.cfg file using any text editor.
• Insert the following line under <System>: Trace=1
• Save the file and restart the PC AFT F. The Trace button now appears in the toolbar. 

Click the Trace button in the toolbar to open the error code window. Delete any old error co-
des using the Clear button. Generate the reproducible errors and save the file. The file is sa-
ved as trace.txt in the PC AFT F root directory. Make a backup copy and send the file to the 
service technician for error analysis.

Only entries contained in the "Contacts" folder are used when running a search in Mi-
crosoft Outlook. Subdirectories are not searched.
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Important Keyboard Commands
You can initiate the most important functions of the PC AFT F using the keyboard.

Keyboard

Answer calls.

Dial station number in General trunk group.

Place calls on hold.

Toggle between two calls.

Park calls.

Disconnect calls.

Dial station number in Private trunk group.

Return to waiting call.

Clear text boxes.

Dial station number.

Space Bar

Alt A+

Alt H+

Alt M+

Alt P+

Alt S+

Alt V+

Alt Z+

Del.
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Function keys

The function keys on your PC keyboard can have the following functions (default assign-
ment), depending on the configuration of your PC AFT F Seite 94:

Call Help.

Find by name.

Terminate call (Clear).

Calls on hold.

Return to the waiting party.

Toggle between two calls.

Park the call.

Override a call.

Activate/deactivate microphone (mute).

Initiate conference.

Search the telephone book.

F1

F2

F3

F4

F5

F6

F7

F8

F9

F10

F12
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